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This guide supplements the information provided to online course developers by the Director of 
Curriculum and Classroom Technology, and information provided to Blackboard instructors 
through the Blackboard Instructor’s Manual.  The material presented here is primarily intended 
to assist course writers with the process of turning their course materials and assignments into an 
appropriate format for online course delivery. 
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This guide assumes that you already know your subject, you know basically how you want to 
develop your course, and you are familiar with the general features of Blackboard.  However, if 
you would like assistance with any of these items, or with any of the techniques discussed in this 
guide, please contact the Director of Instructional Technology at 903-233-3275, or send an email 
message to its@letu.edu  
 
 
I.  Content 
 
After you have identified what content you want to include in your online course, you must 
decide what format will be best for presenting your materials to your students.  The main content 
area you will be using in Blackboard is the Course Documents section. Within this section, 
inside the Control Panel, Blackboard allows you to add several types of content through the 
toolbar at the top of the section (see figure below): 
 

 
Item – this can simply be typed and formatted text that conveys some content to the student.  
An item can also be text with one or more attachments, such as an image file, Word 
document, spreadsheet, or PowerPoint presentation.  Images attached to an item can be 
displayed directly on the screen for the student, while any other type of attachment will result 
in a link that the student must click on in order to access the attachment.  Pictures, audio 
files, video files, Quicktime files, and Flash or Shockwave files can all be inserted into text 
items using the available toolbars, and then displayed as part of the content (without a link).  
An item can also include a link to offline content, which refers to content that students will 
access from a CD.   

 
Tips for Creating Items: 
 
• Enhance text.  Use font effects and color coding where possible to help students recall 

the information they read online.  For example, color all new terms that the student 
must know in green. 

 
• Use other text-editing buttons.  Use the other buttons available in the toolbar above 

your textbox (while entering your text) to create tables, add lines, highlight text, and 
align text. 

 
• Edit images.  Before attaching or inserting an image, use image-editing software to 

adjust the dots per inch (DPI) to 72, and the height and width to the smallest 
appropriate size.  This will help your students load the image faster.   If you do not 
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have an image-editing program, you may want to try IrfanView, available as freeware 
at http://www.irfanview.com  

 
• Provide alternate text for images.  When attaching an image, choose the “Special 

Action” of “Display media file within the page”.  Then after you submit the item, you 
will be given an opportunity to provide “alternate text” for the image.  Provide a short 
description of your image as the alternate text – this text is what screen reader 
programs will read for visually-impaired students. 

 
• Avoid overusing Word documents.  Avoid attaching a Word document that contains a 

short amount of text – instead, simply copy and paste that text into a text item box.  
This will allow the students to access the material more quickly, without having to 
open another document. 

 
• Convert Word documents to Rich Text Format.  When attaching a Word document, 

first save the document as a rich text file (simply open the File menu, choose Save 
As, then specify the “Save as type:” to be “Rich Text Format (*.rtf)”).  This will 
allow students with any word processor to be able to read the document. 

 
• Narrate your PowerPoint presentations.  If you provide your lecture notes through 

PowerPoint presentations, consider narrating your presentations for your online 
students.  Your students will have a much greater understanding of your presentation 
if they can both hear it and see it.  For help with narrating your PowerPoint 
presentations, contact the Director of Instructional Technology at its@letu.edu or 
903-233-3275. 

 
• Convert PowerPoint presentations to web pages.  When attaching a PowerPoint 

presentation, attach it in two different formats:  one as the PowerPoint presentation 
itself, which will allow students to download and print the presentation; another as a 
web page version of the presentation, which will allow the students to view the 
presentation on a computer that does not have PowerPoint installed.  For help in 
converting a PowerPoint presentation to a web page, see Appendix C. 

 
• Insert short media files into a text item.  Use the toolbars above your textbox to insert 

various media files into the text.  You may need to click the triangle at the far left of 
the second toolbar in order to see the third toolbar. 

 

Insert 
media 

buttons
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• Provide large files on CD.  If you have large media files that your students must 
access, consider providing these on a CD.  Then you can create an item with “offline 
content” to link to the files on the CD. 

 
Folder – this creates a folder that can then contain other items and folders.  Folders can be 
used to help organize your content.  Suggested folder ideas for the Course Documents section 
include Lecture Notes, Handouts, Sample Projects, Unit 1 Material, etc.  You can even create 
a folder hidden from student view that contains some special instructions or notes for other 
instructors teaching the course.   

 
Tips for Creating Folders: 
 

• Create items inside the folder.  After you create a folder, click on the title of the 
folder to enter the folder.  Then start creating items, folders, links, etc. inside the 
folder. 

 
• Don’t overuse folders.  When you have too many folders, you are causing your 

students to click too many times to get to the desired content.  Use them wisely. 
 

External Link – this is a link to a web page outside of Blackboard, such as your textbook’s 
web page, or a network share.  You can also attach files to the description of an external link. 

 
Tips for Creating External Links: 
 
• Ensure reliability.  Take advantage of the wealth of resources available to you and 

your students over the Internet by including external links.  Take care, though, to link 
to reliable, verifiable sources. 

 
• Use network shares.  You may want to link to content that is kept on the LeTourneau 

University network, inside of a network share.  This is useful when content is to be 
shared across multiple courses, or when the content must be updated frequently.  For 
more information on network shares, contact the IT department at 
techsupport@letu.edu   

 
Learning Unit – this is similar to a folder, in that it is a collection of other content items.  
However, a learning unit forces sequential access to the pages it contains.  Students must 
view page 1 in the unit before going to page 2, etc.  For example, a learning unit may consist 
of a one-page introduction to the unit, followed by a page that presents some text content for 
the unit, followed by a page that describes an attached picture, followed by an un-graded 
online quiz that checks comprehension of the presentation.  (Note:  to create a learning unit, 
select Learning Unit in the dropdown box at the right of the Course Document screen in the 
Control Panel, and then click Go.) 
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II.  Assignments 
 
You will undoubtedly have more assignments in your online course than you do in your on-
ground courses.  In your on-ground course, you are able to verbally ask your class if they 
understand this concept, or if they have any comments or questions.  And you are able to see 
their faces and know whether they are “getting it.”  However, in an online course, the instructor 
must rely primarily on electronic communication, and thus assigned communications must be 
built in to the design of your course. 
 
Each week, you should have several assignments that give you feedback from your students.  
The section in Blackboard where the assignments are created is appropriately named 
Assignments.  Each assignment may be a stand-alone assignment, or it may be an assignment 
that refers to another section of your course (for example, an assignment requiring students to 
utilize the course Discussion Board may be described within the Assignments section).  Within 
Assignments, you have the same options as those available within the Course Documents area 
discussed earlier.  You also have the ability to create an Assignment using the dropdown box at 
the right of the screen (see figure below): 
 

 
Item – this can be used to create an assignment that requires the use of another part of the 
course site, such as the Discussion Board or Collaboration.  You can also create an item for 
assignments that you want your students to do, but that will not be graded.  For example, you 
could create an item that introduces the week’s activities and instructs the students to begin 
by reading a particular chapter and watching the corresponding presentation. 
 

Tips for Creating Assignments Using “Item”: 
 

• Assign an online discussion.  Create an item that details an online discussion that you 
would like your students to have inside the Discussion Board section.  Be sure to 
create a corresponding forum inside the Discussion Board for this assignment.  
Provide enough directions for your students to understand what makes up an effective 
online discussion, or consider including a rubric for your students.  For a sample 
rubric for grading online discussions, see Appendix C. 

 
• Have students submit project results to Discussion Board.  If you have a project that 

you want your students to share with the class, describe the assignment using an Item, 
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then create a forum in the Discussion Board where students can post their projects as 
attachments to messages.  You may even want students to provide positive comments 
on each others projects, which can be handled through replies within the forum. 

 
• Assign a group chat.  Create an item that describes a group chat that you would like 

your students to conduct inside the Collaboration section.  Be sure to create a 
collaboration session to correspond to this assignment, and start the recording for that 
session (so that you can view transcripts of chat sessions later).  Provide guidelines 
for your students, such as how many people should be in the group chat, what topic 
should they focus on, what roles should be performed (e.g., discussion leader or 
reporter), and how long the chat session should be. 

 
Folder – this again creates a folder that can contain other items and folders.  Each week 
should have a corresponding folder inside the Assignments section.  Inside each week’s 
folder will be an item for the week’s devotional, another item for the week’s learning 
objectives, and another folder where all of that week’s assignments are described.   

 
Test – this is an online quiz, which can consist of multiple choice, multiple answer, 
true/false, fill in the blank, matching, ordering, and essay questions.  Tests can be scheduled 
for a set time period, timed or untimed, and can be set to allow only one attempt, or multiple 
attempts.  Create a multi-attempt test to help your students check their comprehension or 
review for an exam.  Or create a timed test for students to take only one time that will count 
as a major exam.  For online courses, open-book essay questions that test students’ ability to 
apply the learned information will work much more effectively than objective tests. 

 
Tips for Creating Tests: 
 

• Create pools of questions.  Consider creating pools of questions inside the Pool 
Manager for future instructors of your course to use.  Instructors will then be able 
to create their tests by selecting questions from your pools. 

 
• Create multi-attempt tests inside the Assignments section.  For tests that are 

created for review purposes only, with lots of multiple choice and true false 
questions, you may want to go ahead and create these inside the Assignments 
section.  Make them always available, so that future instructors do not have to 
deploy these tests. 

 
• Create timed tests in the Test Manager.  If you feel it is appropriate to have tests 

already created inside your course, do so inside the Test Manager section of the 
Control Panel.  Then when instructors are ready to deploy a test, they will be able 
to choose a ready-made test and make it available for a specified timeframe 
within the Exams and Quizzes section. 

 
Assignment – every assignment that will receive a grade should be created through this 
special “assignment” method.  To do this, you select “Assignment” from the dropdown box 
on the right side of the screen, and then click Go.  Then you will fill in the details for the 
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assignment, including the maximum grade possible.  By using this method for creating an 
assignment, a column is automatically added to the online gradebook.  Students will submit 
their assignments by clicking a “view/complete” link that is automatically created with each 
assignment.  Instructors will view submissions through the gradebook, and will be able to 
provide a grade for the assignment as well as feedback to the student regarding the 
assignment. 

 
Tips for Creating Assignments: 
 
• Request a text response.  Create an assignment that contains an essay question, or a 

few short answer questions.  Students will submit their answers simply by typing into 
the textbox that appears when they click the “view/complete” link.  Consider using 
this type of assignment to check students’ reading comprehension, or to verify student 
viewing of online content, or to summarize the main points they learn each week. 

 
• Request a file to be submitted.  Create an assignment that contains a description of a 

document to be completed, and have your students submit the file to you through the 
“view/complete” link of the assignment.  Consider using this type of assignment for 
research papers, projects, summaries, journals, PowerPoint presentations, etc. 

 
 
III.  Gradebook and Course Evaluation 
 
As the course developer, you will need to decide on the appropriate weights to assign to each 
type of assignment.  In Blackboard, you can assign individual weights to each assignment, or you 
can assign a weight to a category of assignments.  For example, for individual weights, you 
could assign: 
 
 Homework 1  4% 
 Homework 2  6% 
 Homework 3  10% 
 Exam 1  25% 
 Exam 2  25% 
 Final Exam  30% 
 
For category weights, you would assume that each item within a category is equally weighted 
and simply assign an overall weight to the category.  For example,  
 
 Homework    20% 
 Exams   50% 
 Final Exam  30% 
 
Weights are assigned in the Gradebook section of the Control Panel.  The Gradebook should 
automatically contain a column for every “Assignment” type assignment you created, as well as 
for every test.  You will need to create a new item in the Gradebook for any other type of grade 
that needs to be recorded. 
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Appendix A 
 

Course Content Creation Summary 
 
 
Content What to Use in 

Blackboard 
Tips 

Organized content Folder Don’t have empty folders; don’t 
overuse folders 

Online text Item with text Use font effects and color-
coding; use other text-editing 
buttons in toolbar as needed 

Image Item with attached image 
file 

Edit first to use 72 DPI and 
smaller size; provide alternate 
text 

Handout Item with attached Word 
document 

Don’t use for short text items; 
convert to RTF before loading 

Lecture presentations Item with attached 
PowerPoint presentation 

Narrate if possible; provide a 
web page version as well as the 
PowerPoint file 

Online text content 
containing multimedia 
(images, audio, video, 
Quicktime, or Flash) 

Item with media inserted 
into the text using toolbar 
buttons 

Use for shorter media files 

Media files stored on a 
CD 

Item with link to offline 
content 

Use for larger media files; can 
have CDs created and sold with 
textbooks 

Link to web content, or 
to files stored in a 
network share 

External link Ensure reliability of web links 

Online content with 
forced sequential access 

Learning unit  
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Appendix B 
 

Assignment Creation Summary 
 
 
Assignment What to Use in 

Blackboard 
Tips 

Organized assignments Folder Don’t have empty folders; don’t 
overuse folders 

An un-graded 
assignment, or an 
assignment that utilizes 
the discussion board or 
online chat 

Item with or without 
attachments, plus a 
Discussion Board forum or 
a Chat session 

For communication 
assignments, create 
corresponding discussion 
forums or chat sessions  

A project that must be 
shared with the class 

Item with or without 
attachments, plus a 
Discussion Board forum 

Require students to post 
messages to the forum with 
their projects attached 

Online quiz for review 
purposes, with students 
allowed to re-take 

Test with options set for 
multiple attempts 

Include objective questions that 
are automatically graded by 
Blackboard 

Online exam Test with desired options 
set 

Create question pools for future 
instructors; include mostly 
essay questions 

A required paragraph to 
check reading 
comprehension, or to 
verify student viewing 
of online content, or to 
summarize learning 
points each week 

Assignment without 
requiring a file to be 
submitted 

Decide on a grading and 
weighting plan before 
specifying points for each 
assignment 

A research paper, a 
PowerPoint 
presentation, a document 
containing answers to 
several questions, or any 
other student-prepared 
file that needs to be 
submitted 

Assignment with a required 
file submission 

Provide a sample or a model as 
a handout for students to review 
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Appendix C 
 

Converting a PowerPoint Presentation to a Web Page 
 
 
To save the presentation as a web page:  
 

1) In PowerPoint, open the File menu and choose Save As Web Page 
 

2) Click the Change Title button to modify the title that will be displayed in the title bar 
of the browser window 

 
3) Click Web Options from the Tools menu, and change any options as desired; click 

OK when through 
 

4) Specify a location and name for the web page – do NOT include spaces in the file 
name 

 
5) Click Save 

 
NOTE:  Your presentation will be saved as a web page with the specified name, along with a 
folder of the same name plus the extension “_files” containing additional pages and images.  
For example, if you saved your web page as “Chapter3”, there would also be a 
“Chapter3_files” folder on your computer after this process. 
 
To zip the resulting web page files:  
 
NOTE:  The following instructions assume you have the program WinZip installed on your 
computer.  If you do not have WinZip, you can download it and install it from the LeTourneau 
start page – http://www.letu.edu/start 
 

1) Open the Windows Explorer by clicking on Start, pointing to Programs, pointing to 
Accessories, and choosing Windows Explorer 

 
2) Right-click on the web presentation folder that was created when you saved your 

presentation as a web page 
 

3) Click Add to xxxxx.zip, where “xxxxx” represents the name of the folder you 
selected; your Zip file should now be stored in the same folder as your web page 
folder 

 
To upload a web presentation into Blackboard: 
 

1) Log in to Blackboard and enter your course site 
 

2) Click the Control Panel button 
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3) Click Course Documents (or another area where you want the presentation to appear) 

 
4) Click Add Document  

 
5) Enter a title for the document 

 
6) Scroll down and click the Browse button; locate your Zip file, click on that file and 

click Open 
 

7) Type a name for the link (such as “Web presentation”) 
 

8) In the special action drop down box, choose Unpackage these files 
 

9) Click Submit 
 

10) Click the file named “frame.htm”; this will be the starting page for the presentation 
 

11) Click Submit 
 

12) Click Return to Course at the top of the page, and then click Course Documents to 
access the presentation 
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Appendix D 
 

Sample Rubric for Online Discussions 
 
 
  
  8-10 points 6-7 points 4-5 points 1-3 points 
Frequency of 
response 

4 & up 3 times 2 times 1 time 

Evidence of 
having read the 
thread 

Makes reference 
to others' 
responses 

Logic of 
response 
includes other 
responses 

Little evidence 
of having read 
thread 

No evidence of 
having read 
thread 

Evidence of 
having read the 
text or 
applicable 
research 

Makes reference 
to text or other 
publications 

Logic of 
response 
indicates 
reference text or 
other sources 

Little evidence 
of reference to 
readings 

No evidence of 
reference to 
readings 

Adding different 
ideas to the 
thread 

Adds 
considerably to 
the thread 

Adds somewhat 
to the thread 

Adds little to the 
thread 

Adds nothing to 
the thread 

Grammatical 
nature of 
response 

Well-written 
paragraphs using 
correct spelling 
and grammar 

Few spelling and 
grammatical 
errors 

Many spelling 
and grammatical 
errors 

Poorly written 
phrases, 
incomplete 
sentences 

 
 
 
 


